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New Link Engine Powers SpecLink+ LEED
Leadership in Energy and

Environmental Design

A NEWSLETTER FOR BSD SOFTLINK® CUSTOMERS AND FRIENDS

A brand-new link engine in the SpecLink software is more robust and implements linking
faster than ever. Users of the new release will see a noticeable difference in the speed of
many operations, due to a totally new module that is responsible for activating and
updating 125,000 master links and untold numbers of user links. There are no visible
indications of the new link engine in the program, but users will experience the results of
a fast new algorithm that updates project links every time a paragraph with links is
selected. The new linking module is the result of a six-month development effort that
involved a complete overhaul of the previous version to improve reliability and speed.

See LEED, page 4

The US Green Building Council’s LEED
Green Building Rating System has been
around for a few years now, but the
program is now going into high gear.  12
projects were used for a pilot study of the
first version of the rating system (Version
1.0).  Version 2.0 was then refined based
on the feedback from the pilot study plus
additional research into implementation
options and standards.  In June 2001, an
enhanced edition of Version 2.0 came out,
with more information about how to
achieve LEED credits.  At present there is
only one project certified under Version
2.0, but there are 212 registered projects.
Registering a project is the first step in
the certification process, which involves
completing an application with the
required documentation to the USGBC for
review.  LEED Certification can be
achieved on four levels:  the base is
“Certification” (26 points), then there are
“Silver” (33 points), “Gold” (39 points),
and “Platinum” (52 points), with a
maximum of 69 possible points.  As well
as the obvious advantages of having an
energy-efficient and environmentally
sensitive building, a certified building can
be promoted as a “LEED Certified
Building,” is listed on USGBC’s website,
and receives a brass plaque to mount on
the building.  Go to www.usgbc.org for
fees and benefits.

One of the unique characteristics of the BSD SpecLink program is its intelligent linking,
which multiplies user productivity by automatic selection of related paragraphs and
exclusion of incompatible options. As SpecLink has grown in size and complexity, the
old link engine had to work harder and harder to keep track of all the active links in a
project. In addition, links added by users were tracked in a separate table that had to be
merged with the master links for a project. The new link engine uses a more elegant
procedure for determining which links are active and which links take precedence for
every paragraph in a project.
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Achieving the Certified rating (26 of 69
points) should actually be relatively easy,
provided the design is optimized to make
the best use of no-cost options.  There
are six categories of credits:  Sustainable
Sites, Water and Environment, Energy

The new link engine is also better able to detect when there are conflicting links.  A
simple example of conflicting links is where two paragraphs each exclude the other and
both are activated by other links — the link engine cannot tell which of the target
paragraphs is supposed to be included.  If conflicting master links appear, the solution is
to select or exclude manually one of the target paragraphs.  If conflicting project links
appear, the best approach is to remove or modify the offending links, especially in an
office master project used to start new projects.  To help resolve conflicting links, the
link engine displays a message with the section and sequence numbers of paragraphs
affected.

We are pleased with the new release and
hope our users will benefit from the many
improvements included for the winter
quarter.
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TO UPDATE OR NOT TO UPDATE

When you open a project that was created prior to the current
BSD master database, you have three options for how you want
your project to interact with this new master: 1) If you choose not
to update your project, your project does not change at all, but
you will be able to see any new sections or chapters that have
been added to the master database. 2) You can ask SpecLink/
PerSpective to show you exactly what will change should you
choose to update. 3) Or you can choose to automatically merge
the relevant new data in the master with your project, without
affecting your modifications.

See To Update?, page 7

So which option should you choose? Since there are many types
of projects, there is no single answer. The answer actually
changes from project to project and depends on how much time
you have already invested in it and how much time you have left
before the complete project is due.
There are three editing ‘time frames’ for a project:

1. Completed project: It has already been submitted, and you are
keeping it in case you want to reuse it in a new project or for
administrative purposes.

• If you are opening an archived file to see what was
actually issued, choose Do Not Apply Master Paragraph
Updates to Project.

• If you are going to reuse the file, make a copy of the file
and apply the updates when you open the copy. Choose
Apply Master Paragraph Updates to Project, and
uncheck the option Preserve and Mark Deleted
Paragraphs (see note on Apply Master Paragraph
Updates later).

2. Just-begun project: You recently started the project and have
finished editing several sections or chapters.

• If you will have time to look at the documents you have
already edited, then choose Apply Master Paragraph
Updates to Project, and uncheck the option Preserve
and Mark Deleted Paragraphs (see note on Apply
Master Paragraph Updates later).

• If you would like to review the changes in the
documents you have already edited, choose Show
Project Paragraphs Affected by Master Updates.

3. Almost completed project: You will be issuing the
specifications shortly.

• Look over the About Your SpecLink/PerSpective
Update section in the issue of the newsletter that came
with your update disk for changes that would severely
impact your project. If an insignificant number of
changes would affect your project, choose Do Not Apply
Master Paragraph Updates to Project.

• Otherwise, choose Show Project Paragraphs Affected
by Master Updates so you can review the changes to
the entire project.

All the above ‘types’ of projects refer to actual specification
projects. You may also have a pre-edited master project file that
you use to start all new projects. After installing the update, we

recommend that you update your office master using Show
Project Paragraphs Affected by Master Updates. Be sure to
follow that with a complete review and a complete update as
described below.

Notes on the update options:

Do Not Apply Master Paragraph Updates to Project: If you
choose this option, the Updating Project to Current Master
dialog box will continue to open every time you open that
project.

Show Project Paragraphs Affected by Master Updates: Keep in
mind that any project updated with this option is not actually
updated until you accept the update. Documents that have
updated paragraphs in them will appear in magenta type in the
Tree Panel. The status bar next to paragraphs affected by the
update will be a rust color.

You should first review the updates to active documents. An
easy way to find updated documents is to expand the Tree Panel
to show All Levels, and scan for bold magenta text. Magenta
means updated, and bold means active. Next, scan each affected
document for active updated paragraphs by displaying All
Levels in the Document Panel and scrolling through. Scan the
status columns for dark rust. Inactive paragraphs will be lighter.

To view the updated version of a paragraph, click in the
paragraph, and from the Tools menu choose View Updated
Master Paragraph. If you want the new version, click the
Update button. If you do not want the new version, you should
still update the paragraph so you will not continue to review old
changes to that paragraph after subsequent updates. To accept
the update and still keep the old information, copy the paragraph
to a user-added paragraph. Apply the update to the master
paragraph. You may want to exclude the master paragraph and
add a project note explaining to subsequent users which
paragraph to use and why.

After you have reviewed all the active updated sections, decide
whether or not you want to review inactive updated sections.
Typically that is not necessary. Then update the rest of the
project to the master by choosing from the Tools menu, Update
Project to Master. Select the option to update project.
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LinkLine
A BSD SoftLink® Publication
Editor: Marisa Witherspoon
The LinkLine is published by Building
Systems Design, Inc., 1175 Peachtree
Street, Suite 1900, Atlanta, GA 30361.

Permission to use excerpts in other
publications is granted provided the
publisher is notified in advance at (404)
876-4700.

BSD SpecLink, BSD CostLink, and BSD
SoftLink are registered trademarks, and BSD
CadLink and BSD LinkMan are all trademarks
of Building Systems Design, Inc.

Get the latest on BSD by visiting our Web
Page at www.bsdsoftlink.com.

Q&A
I’m trying to install my update and I
keep getting ‘error during move

data process.’ What does this error mean?
The error means that the
installation is unable to overwrite a

file. To get rid of the error, first make sure
no one else is in the software. The update
cannot be installed if any of the program
files are in use. If someone’s computer
crashed while they had the software open,
reboot that computer. Next, disable any
antivirus software.

BSD CostLink/CM

I am trying to copy cost items from
one estimate to another, but the

costs are not coming out the same. Why?
There are a couple of reasons why
the costs would not be exactly the

same when an item is copied from one
estimate to another. The most common
reason is that the resources (labor and
equipment rates) that are part of a line
item have already been defined within the
new estimate with different unit rates than
in the original estimate. The other reason,
as was discovered in this case, could be
that each estimate has different direct cost
columns defined, so that not all of the unit
costs could be copied from one estimate
to the other.

How can I create alternates in my
estimate?
Reporting of alternates is available
with portrait and landscape 1

reports. First be sure to set up your
estimate so that the entire Base Cost is
within your first level one folder, and so
that each of the level one folders after that
contains alternate costs. When your
estimate is complete, from the File menu,
choose Reports Setup. Select Portrait or
Landscape 1, and then select the option
‘Use Level One for Base Cost and
Alternates.’ Click OK. The folder icons for
the alternates now have plus signs on
them. When you print your reports, a total
Base Bid will be printed for the costs in

All Products

your first level one folder, and the
following level one folders will print as
additive or deductive alternates.  If you
need to modify the estimate, it is best to
unclick the Alternates choice, modify the
estimate, and then reclick the choice.

I appreciate being able to add a
hierarchy to my estimate from the

hierarchy library rather than having to
build it from scratch. This is especially
helpful when I want a different WBS for
my project buildings and another for the
site. The only problem is that my
estimates end up with lots of empty
folders that don’t have cost items in them.
Is there a way to get rid of them other
than deleting them one by one?

Yes. When you have finished
adding cost items to your estimate,

select the primary view that has the empty
folders you want to remove. Then from
the Tools menu, choose Delete Empty
Folders. This will remove any folders that
do not have tasks.  Level One folders
must be deleted manually.

I finished my estimate and then
switched to the CSI View and

Assigned Tasks to Hierarchy to get a CSI
summary. I then had to add some
additional cost items and they ended up
in the Unassigned folder. Why?

Whenever you add costs to your
estimate, they are placed in the

Unassigned folders in all of the Primary
Views until you assign them. You can
assign them two ways: by dragging the
cost items from the Unassigned folder to
the appropriate folder, or if the tasks’
source tags match the folder ids, you can
use Assign Tasks to Hierarchy to
automatically assign the cost items to the
appropriate folders.

BSD SpecLink+/BSD PerSpective

I have selected a paragraph by
putting a check in the box, but it

will not become active - the text does not
turn black and it will not print. What’s
wrong?

The most common cause of this
problem is that the parent

paragraph is not active. For instance, if
the paragraph you are selecting is a level
two paragraph (indicated by two dots on
the die in the LVL column), the paragraph
will not become active until you select

and make its level one parent active.
Likewise the parent of the level one
paragraph (the section or chapter title)
must also be active.

In SpecLink, how do I find a section
on a particular product?
There is a catalog listing of all the
sections in a searchable Word

format on the CD. It is located in
\info\SpecPlus\ and is named after the
current quarter, for example
Winter2001.doc.  Open the file and use
Find in your word processor to search for
the section you need.

In PerSpective, how can I get an
overview of the structure and

understand what each chapter is for?
There is a catalog listing of all the
chapters, plus summaries of each in

a searchable Word format on the CD. It is
located in \info\PerSpec\ and is named
ChapterSummaries.doc.

I created a paragraph, and now
when I try to delete it I get the

message “Branch includes Master
Paragraph. Unable to delete.” How can I
delete the paragraph?

Click to place your cursor in the
paragraph you added, then from the

Document menu choose Demote (not
Demote Branch). Now you will be able to
delete the paragraph.
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SpecLink Innovation
at Lord, Aeck & Sargent, Inc.

and Atmosphere, Materials and Resources, [Indoor]
Environmental Quality, and Innovation in Design (special credits
defined for the project).  As an example of a design-controlled
credit, Credit SS 5.2 calls for reducing disturbance of the site by
exceeding the local zoning requirement for open space by 25
percent.  In another case, reduction of heat islands is
accomplished by using either highly reflective roofing or a
vegetated roof.  On the other hand, it may be necessary to
specify some low VOC emission products (paint, adhesives,
sealants, and carpet systems are available credits) but recycled
products, certified wood, or even locally available materials may
not be necessary.  It is certainly not necessary to use state-of-
the-art renewable energy sources or fancy control systems.

LEED Article
cont. from page 1

Lord, Aeck & Sargent is a 75-person architectural firm
headquartered in Atlanta. A winner of many design awards, LAS
has also been notable for its practice innovations. CADD users
since 1978, the firm has produced 100% of its drawings on
CADD since 1991. All LAS employees use computers, and the
firm has developed a number of custom software products.

Specifications at LAS are produced by project architects, using
an office master specification developed and maintained by
Richard Robison, AIA, one of the firm’s principals. Richard is
currently in the midst of transitioning the LAS master into BSD
SpecLink and is editing SpecLink sections and importing text to
tailor it to the project types designed by their three studios
(education, preservation, and science). Assisted by Janet
Diercks, AIA, a BSD specification writer on temporary
assignment to LAS, Richard has embarked on an exciting project
to add a checklist to his SpecLink office master. This checklist is
a separate section comprising a list of most of the products that
are typically used on LAS projects, with subparagraphs that
identify available product options acceptable to LAS. A second
user-added section comprises a list of keywords that are used to
identify products on the drawings.
What makes the checklist and keyword list so innovative are the
links and notes Richard and Janet are adding to the office
master. Links from the product and option subparagraphs in the
checklist automatically select the appropriate product sections

and product choices. Other links to the keyword section
automatically produce an edited set of keywords that can be used
on the drawings. In addition, once a product section has been
selected by a link from the checklist, other user-added links
automatically select LAS standard language in Part 1 and
appropriate accessories in Part 2 and execution in Part 3. Notes
added to the checklist offer the project architects guidance on
appropriate product selections for different circumstances.

The LEED Certification currently applies to new buildings and
reused or renovated buildings.  A rating system for existing
buildings is under development.  The first step in determining
whether to seek Certification is to obtain a copy of the LEED
Rating System document — free-of-charge for downloading at
www.usgbc.org.  After reviewing this 41 page document, which
describes the intent, requirements, and technologies and
strategies for each credit, review the project checklist using
what is known about the proposed project.  Some of the site
selection credits will be obviously impossible — the
“brownfield” redevelopment credit would not apply unless the
site was a “brownfield.”  Others may involve systems that
would not otherwise have been contemplated, such as the
carbon dioxide monitoring system, solar or wind energy

systems, and individually controlled thermal, humidity and
lighting systems.  There are a few requirements the owner would
not have contemplated but which are not optional.  For instance,
the environmental tobacco smoke control prerequisite can be
achieved in only two ways — either prohibit smoking in the
building or provide separately exhausted smoking rooms.  By
including all the prerequisites (non-optional credits), all the easy
credits, all the construction procedures, and energy efficiency
slightly exceeding ASHRAE 90.1, plus a certain number of “good
sense” options, it should be easy to achieve at least 26 points
without even considering recycled materials.  Re-use of existing
building fabric automatically achieves 1 point, with 2 more
possible.

The net result is that a project architect can, in record time,
produce a set of customized project specifications that conforms
to LAS standards even if he or she is not experienced in writing
specs. Simply by checking off the products and product options
needed for a project, the greater part of the project specs are
written automatically.

Since it is LAS policy to write the specifications before the
drawings are complete, the list of keywords generated by
SpecLink can be applied directly to the drawings, assuring that
the drawings and specifications are properly coordinated. Richard
Robison says, “BSD’s Speclink has the features we have looked
for in specification software.  “Out of the box” it comes with a
good foundation of specification text – both generic and
proprietary – yet is completely customizable to our practice.
Essentially we are storing our corporate memory based on our
experience in our region on our projects.  The automated links
from checklist to specs to drawing keynotes make this corporate
memory very accessible to staff architects who are not
specification specialists.”

For owners needing to define their LEED requirements for either
an Architect/Engineer or a Design-Builder, PerSpective offers all
the LEED credits as options for Environmentally Responsible
Design in Chapter 111 - Facility Performance.  The LEED
Certification level required is spelled out, with options to specify
certain credits as required or desirable, or simply to leave the exact
credits up to the design professional.

Design professionals faced with design of a LEED Certified
project need to obtain the LEED Reference Guide (not free-of-
charge).  Registration of the project as described above also
makes technical support available.  To specify achievement of
LEED credits during the construction phase, SpecLink includes
several new and revised sections addressing the construction
procedures credits and certain product requirements.  See the New
Section Synopses in this issue for more information.
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www.aisc.org.

The basic standard for design of modern telecommunications
infrastructure in buildings, TIA/EIA-568 “ Commercial Building
Telecommunications Cabling Standard” has been updated.
Revision B is now three standards, available individually or as a
set, described by TIA as:
•

•

•

For more information, go to www.tiaonline.org.  To order, go to
http://global.ihs.com.

SpecLink+:
•  11 new sections, 8 generic and 3
    proprietary
•  790 sections total, 142 updated (18 %)
•  443 generic sections, 111 updated (26 %)
•  347 proprietary sections, 31 updated (9 %)
•  120,018 links
•  125,902 links
•  16,470 notes to specifier
•  168 standards organizations (107 not
   referenced in PerSpective)
•  2,108 external documents referenced
•  211 documents verified (10 %)
•  25 new or updated documents
•  4 obsolete documents removed
•  182 documents verified as unchanged
•  941 manufacturers listed (84 % with web
   address)
•  862 manufacturers listed in 305 generic
   sections
•  280 manufacturers sponsoring 347
   proprietary sections

PerSpective:
•  178 Chapters
•  25,937 paragraphs
•  28,417 links
•  4,056 notes to specifier
•  77 standards organizations (16 not
   referenced in SpecLink+)
•  615 external documents referenced
•  91 documents verified (15 %)
•  8 new documents
•  83 documents verified as unchanged

Testing, Adjusting, and Balancing:  Two primary standards for
TAB have been extensively revised and reissued.
• The Associated Air Balance Council (AABC)
“AABC National Standards for Total System Balance” 2002
edition replaces the “National Standard for Testing and
Balancing Heating, Ventilating, and Air Conditioning Systems”,
1989 edition.  According to AABC, this standard has been “...
completely re-written and reorganized to reflect the latest
advancements in the test and balance industry.  ... details the
minimum standards for total system balance. Each chapter
covers a specific area in the test and balance process, enabling
the design professional to select those items that are best
suited for a particular project.  ... will assist the design
professional in achieving design intent, provide a better
understanding of the scope of work required of the TAB agency,
and ensure that proper methods and procedures are followed in
the test and balance process.”  For more information and to
order, go to www.aabchq.com.
• The National Environmental Balancing Bureau (NEBB)
“Procedural Standards for the Measurement and
Assessment of Sound and Vibration” 2001 edition replaces
the 1994 edition.  According to NEBB, this standard “... is unique
in content and purpose — not merely an update of previous
materials.  Includes:  Sound and Vibration Instrumentation,
Inspection of Building Construction and Conditions, Interior
Sound Measurement Procedures, Exterior Sound Measurement
Procedures, Vibration Measurement Procedures, NEBB

ABOUT YOUR SPECLINK/PERSPECTIVE UPDATE
Specifications for Sound and Vibration, Sound and Vibration in
Contract Documents, NEBB S&V Report Forms (sample format),
Standards of Performance, and a section on Fundamentals of
Sound, plus tables, equations and glossary.”  For more
information and to order, go to www.nebb.org.
Boiler Testing and Ratings:  The Hydronics Institute (HI)
“Testing and Rating Standard for Heating Boilers” 1989 edition
has been replaced by a new standard: “Testing Standard for
Commercial Boilers” (BTS-2000).  According to HI, “the rating
section is being replaced with a [new, separate] Rating
Procedure book which is the method to acquire I=B=R Ratings
[not yet available].”  For more information and to order, go to
www.gamanet.org.

Bolted Joints:  Two standards for bolted steel joint design have
been combined.  The AISC “Specification for Structural Joints
Using ASTM A325 or A490 Bolts” (S348), 2000 edition, “...
covers the design criteria and normal usage and practices
involved in the everyday use of ASTM A325, A490, and F1852
high-strength bolts in steel-to-steel structural connections,
including strength, slip resistance, installation, and inspection.
The accompanying Commentary provides background and aids
the user in better understanding and applying the provisions.
The previously separate LRFD and ASD versions of this
Specification have also been unified, with LRFD as the basis in
the main body and ASD as an alternative in Appendix B.”  For
more information and to order, go to www.aisc.org, or download
a free copy at www.boltcouncil.org.
Structural Design:  The basic steel design manual, AISC’s
“Manual of Steel Construction, Load and Resistance Factor
Design”, 2001 (third edition), is now available.  Although not
referenced in SpecLink or PerSpective, this manual is an
essential reference for anyone designing steel structures.
According to AISC, “... has been condensed back into a single
volume with all member and connection design information in
one thumb-cut book for easy reference.  All current structural
shapes are covered, and guidance is provided for the new
OSHA safety regulations, stability bracing requirements and
proper material specification. Additional new information is
provided on design drawing information requirements, criteria
needed for connection design, mill, fabrication and erection
tolerances, façade issues, temperature effects and fire
protection requirements with summaries of common UL
assemblies.  For more information and to order, go to

STATISTICS

HVAC

STEEL CONSTRUCTION

TELECOMMUNICATIONS

Part 1: General Requirements:  “This standard specifies a  generic
telecommunications cabling system for commercial  buildings that will
support a multi-product, multi-vendor environment.”
Part 2: Balanced Twisted-Pair Cabling Components:  “This  standard
specifies cabling components, transmission, system models, and the
measurement procedures needed for verification of balanced
twisted pair cabling.”
Part 3: Optical Fiber Cabling Components Standard:  “This standard
specifies the component and transmission requirements for an
optical fiber cabling system (e.g., cable, connectors).”
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07211 - REFLECTIVE INSULATION AND RADIANT BARRIER:  This
new proprietary section covers reflective foil and radiant barriers
made by Ayr Reflective, Inc.

09625 - RESILIENT ATHLETIC FLOORING:  This new generic
section covers fluid-applied polyurethane flooring; rubber and
vinyl sheet floor coverings; and interlocking, non-adhered
rubber tile.  It does not include indoor-outdoor carpet or resilient
wood floors used for athletics.  The manufacturers listed are:

1. Fluid Applied:  Connor Sports Flooring; Martin
Surfacing, Inc.; and Robbins Sports Surfaces.

2. Sheet and Tile:  American Floor Products Company;
Pawling Corporation; and Robbins Sports Surfaces.

09850 - ACOUSTICAL PANELS:  This new generic section
covers fabric-covered panels for back-mounting to walls or
ceilings and for use as ceiling-hung baffles.  The types of
panels covered include panels with cores of fiberglass or
mineral fiber, with hardened edges, concealed frames of wood,
galvanized steel, or aluminum, and optional trim. Mounting
accessories are also included.  The manufacturers listed are
Armstrong World Industries, Inc.; Essi Acoustical Products
Company; and USG Interiors, Inc.

12615 - FIXED THEATER SEATING:  This new generic section
covers upholstered and non-upholstered interior seating with
and without folding seats.  It does not include stadium or sports
arena seating for exterior use, or telescoping bleachers for
interior or exterior use.  The manufacturers listed are American
Premier Seating Company; American Seating Company;
Hussey Seating Company; and Theatre Solutions, Inc.

15839 - VEHICLE EXHAUST SYSTEM:  This new proprietary
section covers wall, ceiling, and boom mounted systems, with
and without blowers, made by Airflow Systems Inc.

Major Revisions to Existing Sections

01100 - SUMMARY:  This existing generic section has been
revised to better describe scope of alterations and salvage of
existing materials, which can help achieve LEED Materials and
Resources Credits 1 (building re-use) and  3 (resource re-use).

01600 - PRODUCT REQUIREMENTS:  This existing generic
section has been revised to address use of existing materials,
which can help achieve LEED Materials and Resources Credits
1 (building re-use) and  3 (resource re-use).

01700 - EXECUTION REQUIREMENTS:  This existing generic
section has been revised to better address alterations
procedures, by including an explicit article on the subject and by
including the selective demolition provisions of former Section
02223 - Minor Demolition for Remodeling.  Section 02223 has
been melded into Section 01700 to eliminate the duplication
between the two sections and to place selective demolition in
the standard Masterformat location for that subject.  Note:
Section 02223 remains in the SpecLink master database for
use on existing projects but it has been removed from Section
00010 - Table of Contents and will not be updated nor improved
in the future — we recommend that users cease using it as
soon as possible.

09300 - TILE:  This existing section has been revised to include
a wider selection of non-ceramic trim for tile (metals and
plastics) and to include uncoupling membrane for thin-set tile

NEW SECTION SYNOPSES
01115 - GREEN BUILDING REQUIREMENTS:  This new generic
section explains the LEED rating system to the contractor,
states which credits will be achieved by the design, and
includes a list of Related Sections where provisions intended
to address specific credits are specified.  This section also
includes optional “green” product requirements that apply to
many different specification sections, such as formaldehyde-
free wood products, low-VOC adhesives, and Forest
Stewardship Council certified wood.  It also includes a scheme
by which credits for recycled and renewable materials are
justified by means of a Contractor reporting system tied to
Applications for Payment.

01575 - TEMPORARY EROSION AND SEDIMENTATION
CONTROL:  This new generic section addresses the LEED
Sustainable Sites Prerequisite, which addresses erosion and
sedimentation during the construction phase, by placing the
burden of compliance on the contractor.  Permanent erosion
and sedimentation control, which is addressed by several
other LEED credits, must be accomplished by the design and
construction.

01732 - WASTE MANAGEMENT:  This new generic section
addresses two LEED Materials and Resources credits (MR 2.1
and 2.2) by requiring diversion of as much waste as possible
from landfills, placing the burden of compliance on the
contractor with a reporting system tied to Applications for
Payment.  Based on case studies, it should be feasible for a
contractor to achieve at least 50 percent site waste reduction,
which is the minimum achievement for one credit.  A second
credit is available for over 75 percent reduction.

01734 - INDOOR AIR QUALITY:  This new generic section
addresses several LEED Environmental Quality prerequisites
and credits:

1. Minimum construction procedures to ensure good IAQ
in the completed building (EQ Credit 3.1).

2. Two-week building flush out (to achieve EQ Credit 3.2)
or air contaminant testing (to verify achievement of EQ
Credit 3.2); either one or the other, at the contractor’s
option.

3. Testing of smoking rooms (smoking rooms are one of
the options of Environmental Quality Prerequisite 2).

4. Ventilation effectiveness testing (to verify achievement
of EQ Credit 2); ventilation design requirements are
not specified in this section.

02200 - SITE PREPARATION:  This new generic section
replaces 02230 - Site Clearing and 02221 - Building
Demolition.  It includes vegetation removal limits and
protection of existing vegetation (to achieve LEED SS Credit 5,
reduced site disturbance)  and requires chipping or grinding all
clearing debris (probably necessary to achieve the LEED
waste management credit on rural and suburban sites).  Note:
Sections 02221 and 02230 remain in the SpecLink master
database for use on existing projects but they have been
removed from Section 00010 - Table of Contents and will not
be updated nor improved in the future — we recommend that
users cease using them as soon as possible.

05425 - PRE-ENGINEERED COLD-FORMED STEEL TRUSSES:
This new proprietary section covers roof and floor trusses
made from components factory-manufactured by MiTek
Industries, Inc.



7

SpecLink Includes New
Resources For Specifiers

New this quarter are hyperlinks from the
notes to building product manufacturers’
technical data.  This exciting new feature
is in an embryonic stage — if you like how
it functions and want to see more, be sure
to ask manufacturers for it.  There are
three degrees of linking possible,
represented by the three examples
currently in the Winter master.  Take a look
at the following:

Links to Model Specifications and
Detailed Technical Data:  See Section
09300 - TILE, Sequence 0140 (Part 2, Trim
and Accessories, Non-Ceramic Trim,
Manufacturers, Schluter Systems:
www.schluter.com).  The note at this
paragraph makes it possible to jump right
to the manufacturer’s web site, where
diagrams, finish options, and sizes are
shown in detail.  Another link jumps to the
manufacturer’s long form tile accessories
specification, a Word file, which describes
each accessory in detail.  The individual
accessory specs can be pasted into a
SpecLink project using Copy/Paste or
Import From Clipboard (remember to
remove the paragraph numbers first).

To Update?
cont. from page 2

floor applications.  The latter is the material described in two
TCA installation methods — Methods F147 and F148 — in
the current TCA Handbook for Ceramic Tile Installation, 2001
edition.  These TCA methods have also been added to the
installation options in PART 3.

Note:  A special feature in this section for both of these
products is the addition of hyperlinks in the notes to
jump to manufacturer information on the Internet.  Both
of these products are made by Schluter Systems, who
has provided links to their web site for 1) a complete
detailed specification on all their non-ceramic trim and
tile installation accessories and 2) their complete
product literature, diagrams, and technical data.

New Section Synopses
cont. from page 6

Apply Master Paragraph Updates to Project: When you select
this option, the choice Preserve and Mark Deleted Paragraphs
becomes available. Part of updating the master includes
deleting obsolete reference standards and language that is no
longer appropriate. Leaving this option selected will leave
those paragraphs in your project. To locate the deleted
paragraphs, scan the Tree Panel for magenta titles, and in the
document panel scan the status columns for rust. You can also
view the update log. Your project is not completely updated
until these deleted paragraphs have been removed. If you
want to keep any of the deleted paragraphs, copy and paste
them as user-added paragraphs, then from the Tools menu
choose Update Project to Master.

Other options in the Updating Project to Current Master
dialog box:

Make Project Backup Before Updating: If you already have a
backup copy of the project, deselect this option. Otherwise, a
copy of your project as it was before the update will be created
in the same folder as the updated project; it will be named
Backup 1 of [filename]. If you accidentally choose the wrong

update option or want to verify the differences between the
updated and the original, you can use the backup.

Print Log File: Whether you select this option or not, the software
generates a log of all the paragraphs in your project affected by the
update. If you select this option, it will be automatically printed by
your default printer. You can always locate the log later in the same
folder as the updated project; it will be named Log 1 of [filename].

There is also a “SpecLink-friendly” version of
the specification, in the event you want to
import the entire specification into a new
user-added section — SpecLink-friendly
means the paragraph numbers have already
been removed.  Another link to the
manufacturer’s site appears at Sequence 0191

(Part 2, Accessory Materials,
Uncoupling Membrane, Acceptable
Product).

Link to Detailed Technical Data:  See
Section 05400 - Cold Formed Metal
Framing, Sequence 0079 (Part 2,
Manufacturers, Metal Framing
Connectors and Accessories, The
Steel Network) and 0112 (Part 2,
Framing Materials, Framing
Connectors, Acceptable Product).  The
notes at these paragraphs include
information on the framing connectors
made by The Steel Network and links
to the manufacturer’s web site, where
detailed technical and graphic
information is available.

Link to Manufacturer’s Entire Web
Site:  See Section 07530 - Elastomeric
Sheet Roofing, Sequence 0089 (Part 2,
Manufacturers, EPDM Membrane
Materials, Firestone Building
Products).  The note at this paragraph
includes information about how to
contact Firestone, a summary of the
products they make, and a link to their
web site where a wide array of
information is available.
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BSD CostLink/CM (M32)
3-1/2 days*  $1295

January 29 - February 1
March 12 - 15

April 30 - May 3
July 9 - 12

August 27 - 30
October 8 - 12
December 3 - 6

•  Government Contractors earn Mcaces
Certification.

•  May qualify for Continuing
Professional Competency credits.

2002 Training Schedule

You can now look for BSD class schedules on our Internet site.  Just go to
www.bsdsoftlink.com and go to the training page.  You will find schedules, maps,
hotel information, and information about Atlanta.

PRESORTED STANDARD
U.S. POSTAGE

PAID
ATLANTA, GA

PERMIT No.6613

Building Systems Design, Inc.
1175 Peachtree Street, Suite 1900
Atlanta, GA 30361

BSD SpecLink+
1-1/2 days*  $495

January 7 - 8
February 4 - 5

March 4 - 5
April 8 - 9

May 13 - 14
June 10 - 11
July 15 - 16

September 16 - 17
October 21 - 22

November 18 - 19

•  AIA Members: Earn 12 Continuing
Education Units that qualify for Health,

Safety, and Welfare hours.
•  CSI Members: Earn 12 Education

Contact Hours (ECH’s) toward your CCS,
CCCA, or CCPR Certification renewal.

BSD PerSpective
2 days*  $695

January 9 - 11
February 6 - 8

March 6 - 8
April 10 - 12
May 15 - 17
June 12 - 14
July 17 - 19

September 18 - 20
October 23 - 25

November 20 - 22

•  AIA Members: Earn 16 Continuing
Education Units that qualify for Health,

Safety, and Welfare hours.
•  CSI Members: Earn 16 Education

Contact Hours (ECH’s) toward your CCS,
CCCA, or CCPR Certification renewal.

*Class starts at 12:30 PM on Monday
afternoon and ends at 5 PM on Tuesday.

*Class starts at 12:30 PM on Wednesday
afternoon and ends at 12:30 PM on Friday.

*Class starts at 8:30 AM on Tuesday
morning and ends at 11:30 AM on Friday.


